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L֨I NčI ņӹU 

ņ֟ h֙a m§y t²nh l¨ m֥t trong nhֻng lǫnh vֽc l² th¼ nhӸt v¨ ph§t triԜn nhanh 

nhӸt cֳa tin h֙c. Ngay tַ khi xuӸt hi֓n, Ľ֟ h֙a m§y t²nh Ľ« c· sֵc l¹i cu֝n m«nh 

li֓t, cu֝n h¼t rӸt nhiԚu ngҼ֩i ֫ nhiԚu lǫnh vֽc kh§c nhau nhҼ khoa h֙c, ngh֓ thuԀt, 

kinh doanh, quӶn l², ...  Ng¨y nay, Ľ֟ h֙a m§y t²nh ĽҼ֯c sֹ dֱng trong rӸt nhiԚu 

lǫnh vֽc kh§c nhau nhҼ c¹ng nghi֓p, thҼҺng mӴi, quӶn l², gi§o dֱc, giӶi tr², é 

M¹n h֙c Ľ֟ h֙a ֵng dֱng cung cӸp cho h֙c sinh  nhֻng kiԒn thֵc xֹ lĨ, c§ch kԒt 

h֯p nhiԚu h³nh Ӷnh kh§c nhau th¨nh m֥t Ӹn phӼm Ľ֟ hoӴ, b°n cӴnh Ľ· bӴn c¸n 

ĽҼ֯c trang b֗ k׃ thuԀt sֹ lĨ m¨u sԂc, ch֕nh sֹa Ӷnh cȈé   

 M¹ Ľun ņ֟ h֙a ֵng dֱng thu֥c nh·m c§c m¹ Ľun chuy°n ng¨nh bԂt bu֥c 

ĽҼ֯c b֝ tr² giӶng dӴy cho h֙c sinh cu֝i nŁm thֵ nhӸt hoԊc ĽӺu nŁm thֵ hai. N֥i 

dֱng chҼҺng tr³nh g֟m 7 b¨i: 

- Bài 1: Tr³nh b¨y nhֻng  kh§i ni m֓ cҺ bӶn trong Photoshop, m¹i trҼn֩g l̈ m 

vi c֓ v̈  tác dֱ ng, c§ch sֹ dֱng c§c công cֱ  thông dֱ ng trong Photoshop. 

- Bài 2: Trình bày  c§c thao t§c, các l֓ nh xֹ  lĨ v֧i v½ng ch֙ n.  

- Bài 3: Tr³nh b¨y kh§i ni֓m vԚ lp֧ trong Photoshop, các thao tác trên layer, 

v¨ c§ch §p dֱng c§c chԒ Ľ֥ h¸a tr֥n tr°n layer. 

- Bài 4: Tr³nh c§ch tӴo vŁn bӶn trong Photoshop, c§ch ch֕nh sֹa h³nh dӴng, 

k²ch thҼ֧c vŁn bӶn.  

- Bài 5: Tr³nh b¨y c§c Ľ ֥hiԜn th֗  h³nh Ӷnh trong m¹i trҼn֩g Photoshop, các 

l֓nh ĽiԚu ch֕nh m¨u sԂc tr°n layer v¨ v½ng ch֙n, c§c chԒ Ľ֥ m¨u cung nhҼ 

c§ch §p dֱng c§c b֥ l֙c th¹ng dֱng trong Photoshop 

- Bài 6: Tr³nh b¨y c§c kǫ thuԀt n©ng cao trong photoshop nhҼ kǫ thuԀt sֹ dֱng 

mԊt nӴ, sֹ dֱng layer ĽiԚu ch֕nh, layer t¹ m¨u... 

- Bài 7: Tr³nh b¨y c§c kǫ thuԀt v֧i k°nh mӺu v¨ in Ӹn h³nh Ӷnh. 

N֥i dung cu֝n s§ch ĽҼ֯c d½ng ĽԜ giӶng dӴy bԀc cao ĽԆng v¨ trung cӸp nghԚ  

chuy°n ngh¨nh c¹ng ngh֓ th¹ng tin. Gi¼p cho sinh vi°n c· kiԒn thֵc cҺ bӶn nhӸt 

vԚ h֓ Ľ֟ h֙a.  

Do kinh nghi֓m v¨ th֩i gian c¸n hӴn chԒ, t¨i li֓u chԂc chԂn kh¹ng thԜ tr§nh 

kh֛i nhֻng thiԒu s·t. RӸt mong nhԀn ĽҼ֯c c§c Ĩ kiԒn Ľ·ng g·p v¨ x©y dֽng cֳa 

c§c bӴn Ľ֙c. ħ kiԒn Ľ·ng g·p xin gֹi vԚ: Khoa ņi֓n tֹ - C¹ng ngh֓ th¹ng tin, 

trҼ֩ng Cao ĽԆng nghԚ Y°n B§i. 
Y°n B§i, th§ng 07 nŁm 2013 

                         T§c giͩ 
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Bài 1  

LêM QUEN V֦I MĎI TRһ֨NG LêM VI֒C 

CֲA PHOTOSHOP 

 

1. C§c kh§i ni֓m trong PhotoShop 

1.1.ņiԜm Ӷnh (pixel  ï px) 
L¨ nhֻng phӺn tֹ h³nh vu¹ng cӸu tӴo n°n file Ӷnh. N·i c§ch kh§c 1 file Ӷnh 

l¨ tԀp h֯p cֳa nhiԚu ĽiԜm Ӷnh, s֝ lҼ֯ng và Ľ֥ l֧n cֳa c§c ĽiԜm Ӷnh trong file Ӷnh 

phֱ thu֥c v¨o Ľ֥ ph©n giӶi cֳa file Ľ·. 

1.2.ņ֥ ph©n giӶi 

 L¨ s֝ lҼ֯ng ĽiԜm Ӷnh tr°n 1 ĽҺn v֗ d¨i (thҼ֩ng d½ng inch). 

VD: ņ֥ ph©n giӶi cֳa Ӷnh bԄng 72  c· nghǫa l¨ c· 72 ĽiԜm Ӷnh tr°n 1 inch d¨i. Có 

thԜ n·i nԒu Ľ֥ ph©n dӶi thӸp th³ s֝ lҼ֯ng ĽiԜm Ӷnh ²t, di֓n t²ch cֳa px l֧n, h³nh 

Ӷnh sԐ không ĽҼ֯c r» n®t. 

1.3.V½ng ch֙n(Selection ) 

 L¨ miԚn ĽҼ֯c gi֧i hӴn bԄng ĽҼ֩ng bi°n và n®t Ľֵt ĽҼ֯c d½ng ĽԜ quy v½ng 

sֹ l² ri°ng. M֙i thao t§c sֹ lĨ h³nh Ӷnh ch֕ c· t§c dֱng b°n trong v½ng ch֙n. V½ng 

ch֙n ĽҼ֯c tӴo ra bԄng c§c c¹ng cֱ tӴo v½ng ch֙n hoԊc 1 s֝ l֓nh tӴo v½ng ch֙n 

khác. 

1.4.Layer (l֧p Ӷnh) 

L¨ l֧p Ӷnh, trong 1 layer chֵa c§c v½ng c· ĽiԜm Ӷnh hoԊc kh¹ng c· ĽiԜm 

Ӷnh. V½ng kh¹ng c· ĽiԜm Ӷnh ĽҼ֯c g֙i l¨ v½ng trong su֝t (Transparent). 

1.5.M¨u tiԚn cӶnh (Forground),  m¨u hԀu cӶnh (Background) 

L¨ 2 h֥p m¨u cҺ bӶn cֳa Photoshop nԄm tr°n h֥p c¹ng cֱ. BiԜu tҼ֯ng cֳa 2 

c¹ng cֱ n¨y l¨ 2 h³nh vu¹ng ch֟ng l°n nhau nԄm ֫ gӺn cu֝i h֥p c¹ng cֱ.  

+ M¨u tiԚn cӶnh : L¨ m¨u sԐ ĽҼ֯c t¹ v¨o Ӷnh  

+ M¨u hԀu cӶnh : L¨ m¨u sԐ ĽҼ֯c t¹ v¨o giӸy 

 MԊc Ľ֗nh m¨u tiԚn cӶnh l¨ mӺu Ľen, c¸n m¨u hԀu cӶnh l¨ m¨u trԂng. ņԜ thay 

Ľ֡i m¨u mԊc Ľ֗nh ta bӸm chu֥t v¨o tַng ¹ m¨u ĽԜ thay Ľ֡i. Mu֝n tr֫ vԚ m¨u 

mԊc Ľinh nhӸn ph²m D. ņԜ thay Ľ֡i qua lӴi giֻa 2 m¨u nhӸn ph²m X.  
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2. Giao di֓n chҼҺng tr³nh 

 M¹i trҼ֩ng l¨m vi֓c cֳa photoshop bao g֟m 5 phӺn cҺ bӶn l¨: Thanh menu, 

thanh option, thanh trӴng th§i, h֥p c¹ng cֱ v¨ c§c Palettes.    

 Giao di֓n photoshop CS2 cҺ bӶn nhҼ sau:  

 

 

ü C§c Th¨nh PhӺn Tr°n Cֹa S֡ Giao Di֓n  

- Thanh Ti°u ņΖ: Chֵa ti°u ĽԚ chҼҺng tr³nh ֵng dֱng Adobe Photoshop. 

Chֵa Ba Button chֵc nŁng:  

o Close Button: - ņ·ng chҼҺng tr³nh ֵng dֱng. 

o  Restore Button: Ph·ng to/ Thu nh֛ cֹa s֡ chҼҺng trình.  

o  Minimizes Button: TӴm th֩i Ӽn cֹa s֡ chҼҺng tr³nh ֵng dֱng l°n thanh 

t§c vֱ. 
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- Thanh Menu: G֟m c· 9 Menu chֵc nŁng: 

o Menu File: Chֵa c§c chֵc nŁng li°n quan ĽԒn thao t§c tr°n tԀp tin: M֫ m֧i 

tԀp tin, M֫ tԀp tin c· sԆn, LҼu tԀp tin, In Ӹné 

o Menu Edit: Chֵa c§c chֵc nŁng li°n quan ĽԒn vi֓c hi֓u ch֕nh tԀp tin trong 

qu§ tr³nh thao t§c nhҼ: Tr֫ vԚ thao t§c liԚn trҼ֧c, thao t§c liԚn sau. Sao 

ch®p, di chuyԜn n֥i dung v¨o v½ng nh֧ tӴm, d§n n֥i dung tַ v½ng nh֧ tӴm 

v¨o v½ng Ӷnhé 

o  Menu Image: Chֵa c§c l֓nh vԚ bi°n tԀp h³nh Ӷnh: ChԒ Ľ֥ m¨u, Quay h³nh 

Ӷnhé 

o  Menu Layer: Chֵa c§c chֵc nŁng xֹ lĨ l֧p. 

o  Menu Select: Chֵa c§c chֵc nŁng li°n quan ĽԒn thao t§c ch֙n và thôi 

ch֙n h³nh Ӷnh, biԒn Ľ֡i v½ng ch֙n. 

o  Menu Filter: Chֵa c§c chֵc nŁng tӴo hi֓u ֵng tr°n Ӷnh. 

o  Menu View: Chֵa c§c chֵc nŁng x§c lԀp chԒ Ľ֥ hi֓n th֗ h³nh Ӷnh. 

o  Menu Window: Chֵa c§c chֵc nŁng hiԜn th֗ hay Ӽn c§c Palette cֳa 

chҼҺng tr³nh. 

o  Menu Help: Chֵa c§c th¹ng tin tr֯ gi¼p sֹ dֱng chҼҺng tr³nh Adobe 

Photoshop. 

- Palettets Chοc nŁng: 

Photoshop thԜ hi֓n chֵc nŁng th¹ng qua giao tiԒp tr°n Palette. M֣i bӶng 

Palette sԐ chֵa c§c chֵc nŁng ri°ng cֳa palette Ľ·, n· gi֝ng nhҼ l¨ m֥t h֥p 

thoӴi. G֟m c· c§c palette sau: 

o  Palette Navigator: Gi¼p trҼ֯t h³nh Ӷnh v¨ ĽiԚu ch֕nh t֕ l֓ hiԜn th֗ cֳa hình 

Ӷnh. 

o  Palette Info: Cho biԒt th¹ng tin m¨u tӴi v֗ tr² con tr֛ cȈng nhҼ c§c th¹ng tin 

khác t½y thu֥c v¨o c¹ng cֱ ĽҼ֯c ch֙n. 

o  Palette Layer: QuӶn lĨ l֧p cֳa Ľ֝i tҼ֯ng.  

o  Palette Style: Chֵa c§c mӾu Style cֳa l֧p. 

o  Palette Chanel: Gi¼p quӶn lý kênh màu. 

o  Palette Action: Gi¼p tӴo v¨ quӶn l² c§c thao t§c tֽ Ľ֥ng. 

o  Palette Color/ Swatches: D½ng ĽԜ ch֙n m¨u. 
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o  Palette History: LҼu c§c trӴng th§i hi֓u ch֕nh Ӷnh. 

TuȢ theo c¹ng vi֓c m¨ bӴn c· thԜ l¨m xuӸt hi֓n hoԊc Ӽn các paletter. Vào 

meu Window/ch֙n <t°n bӶng paletter> cӺn hiԜn th֗. 

- Thanh t½y chΣn (option):   

TӸt cӶ c§c c¹ng cֱ ĽԚu c· c§c tuȢ ch֙n ri°ng cֳa n·, v¨ c§c tuȢ ch֙n n¨y 

ĽҼ֯c thԜ hi֓n tr°n thanh tuȢ ch֙n cֳa c¹ng cֱ. 

 Thanh tuȢ ch֙n lu¹n thay Ľ֡i theo ĽԜ ph½ h֯p v֧i tַng c¹ng cֱ Ľang ĽҼ֯c 

ch֙n, m֥t v¨i thanh tuȢ ch֙n v¨ bӶng c· c§c tuȢ ch֙n cho ph®p bӴn nhԀp v¨o 

c§c gi§ tr֗ s֝ bԄng c§ch sֹ dֱng thanh trҼ֯t, phӺn Ľ֗nh g·c, c§c n¼t mȈi t°n h֥p 

nhԀp. H³nh dҼ֧i là thanh tùy ch֙n cֳa c¹ng cֱ Erase. 

 

- Thanh trͧng th§i: 

NԄm dҼ֧i c½ng cֳa m¨n h³nh l¨m vi֓c. ThԜ hi֓n c§c th¹ng tin vԚ file Ӷnh 

khi Ľang thao t§c v֧i file Ӷnh Ľ· nhҼ Ľ֥ ph·ng ĽӴi, k²ch c֭ cֳa file Ӷnhé 

 

- Hίp c¹ng cλ (tool box) 

H֥p c¹ng cֱ l¨ lҺi chֵa c§c c¹ng cֱ cֳa Photoshop, c§c c¹ng 

cֱ ĽҼ֯c chia l¨m 3 nh·m : 

o Nh·m c¹ng cֱ tӴo v½ng ch֙n, di chuyԜn v¨ cԂt Ӷnh. 

o Nh·m c¹ng cֱ vԐ.  

o Nh·m c¹ng cֱ tӴo Path, ch֕nh sֹa Path v¨ g» vŁn bӶn. 

Ngo¨i c§c c¹ng cֱ. Toolbox c¸n chֵa c§c phim chuyԜn Ľ֡i qua 

lӴi giֻa c§c chԒ Ľ֥ l¨m vi֓c v¨ 2 ¹ m¨u tiԚn cӶnh, hԀu cӶnh. 
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3. M ,֫ tӴo, lҼu file Ӷnh 

Trong photoshop ĽԜ bԂt ĽӺu l¨m vi֓c, thҼ֩ng ta phӶi lԀp m֥t tԀp tin m֧i hoԊc 

m֫ m֥t file Ӷnh n¨o Ľ· Ľang c· sԈn trong m§y t²nh. V¨  Ľ¹i khi ta phӶi   m֫  c½ng 

l¼c nhiԚu tԀp tin tr°n m¨n h³nh ĽԜ ch֙n lֽa, sao ch®p, cԂt gi§né 

3.1.M֫ file 

ņҼ֩ng dӾn: Menu File / Open (Ctrl + O) hoԊc k²ch Ľ¼p v¨o ch֣ tr֝ng cֳa 

giao di֓n photoshop, bӶng thoӴi Open hi֓n ra, ch֙n file Ӷnh cӺn ch֕nh sֹa, sau Ľ· 

ch֙n open. 

 

 

3.2.TӴo file m֧i 

ņҼ֩ng dӾn: menu File / New ( Ctrl + N ) ĽԜ g֙i bӶng thoӴi New  nhҼ h³nh sau: 
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Trong Ľ·:  

+ Name : ņԊt t°n cho file Ӷnh 

+ Width : Kích thҼ֧c chiԚu ngang bֵc Ӷnh. 

+ Height : K²ch thҼ֧c chiԚu d֙c bֵc Ӷnh. 

+ Resolusion : ThiԒt lԀp Ľ֥ ph©n giӶi. 

+ Color Mode: ņԊt ChԒ Ľ֥ mӺu cho file Ӷnh.  

+ Background Contents: Ch֙n mӺu nԚn cho layer Background. Trong trҼ֩ng 

h֯p kh¹ng mu֝n ĽԊt m¨u n°n, lֽa ch֙n  Transparent, layer Background tr֫ 

l°n trong xu֝t. 

NhӸn ok  ĽԜ ho¨n tӸt qu§ tr³nh tӴo file Ӷnh m֧i  

3.3.LҼu file 

Ch֙n File > Save lҼu tԀp tin ĽӺu ti°n (hoԊc save as v֧i m֥t phӺn m֫ r֥ng 

kh§c, m֥t nҺi kh§c).  

 

Trong Ľ·: 

Á Save in: X§c Ľ֗nh ĽҼ֩ng dӾn ĽԜ lҼu giֻ tԀp tin  
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Á File name: ĽԊt t°n tԀp tin 

Á Format: ch֙n loӴi t֓p tin ĽҼ֯c lҼu. 

Ch֙n n¼t Save ĽԜ ho¨n tӸt qu§ tr³nh lҼu tԀp tin. Ta n°n lҼu thҼ֩ng xuy°n trong 

su֝t qu§ tr³nh l¨m vi֓c ĽԜ tr§nh t³nh trӴng h֛ng tԀp tin khi c· sֽ c֝ bӸt ng֩ xӶy ra 

nhҼ treo m§y, mӸt Ľi֓né  

C§c Ľ֗nh dӴng file hay d½ng trong photoshop: 

+ PSD (photoshop) 

DӴng file mԊc Ľ֗nh. H֣ tr֯ tӸt cӶ c§c chԒ Ľ֥ cֳa h³nh Ӷnh 

+ AVI (Audio Video Interlace) 

DӴng thֵc Windows chuӼn d¨nh cho dֻ li֓u audio /video 

+ BMP (Bitmap) 

DӴng Ӷnh Windows chuӼn tr°n c§c m§y t²nh tҼҺng th²ch DOS v¨ WINDOWS 

+ EPS(Escapsulated PostScript) 

DӴng file c· thԜ chֵa cӶ hai Ľ֟ hoӴ vector và bitmap ĽҼ֯c h֣ tr֯ b֫i hӺu hԒt 

c§c chҼҺng tr³nh Ľ֟ hoӴ. 

+ DCS(Desktop Color Separations) 

M֥t phi°n bӶn cֳa dӴng EPS chuӼn cho ph®p ta lҼu c§c bӶn ph©n t§ch mӺu 

cֳa Ӷnh CMYK 

+ GIF(Graphics Interchange Format) 

DӴng thֵc t֓p tin ĽҼ֯c d½ng ĽԜ hiԜn th֗ Ľ֝i tҼ֯ng Ľ֟ hoӴ v¨ h³nh Ӷnh 

Indexed Color trong t¨i li֓u HTML. GIF bӶo to¨n v½ng trong su֝t trong Ӷnh  

+ JPEG(Joint Photographic Experts Group) 

ņҼ֯c d½ng ĽԜ hiԜn th֗ Ӷnh chֱp v¨ c§c Ӷnh mӺu li°n tֱc trong t¨i li֓u HTML 

JPEG giֻ lӴi to¨n b֥ th¹ng tin mӺu trong Ӷnh RGB song n®n k²ch thҼ֧c tԀp 

tin bԄng c§ch loӴi b֛ dֻ li֓u m֥t c§ch c· ch֙n l֙c 

+ PDF - Portable Document Format 

Dֽa v¨o m¹ h³nh tӴo Ӷnh Postscript, t֓p tin PDF hiԜn th֗ ch²nh x§c v¨ bӶo 

to¨n ph¹ng chֻ, b֝ cֱc trang, cӶ Ľ֝i tҼ֯ng Vector và Bitmap. 

+ PNG- Portable Networks Graphics 

ņҼ֯c d½ng c· thԜ thay thԒ cho dӴng thֵc GIF. Tuy nhi°n, kh§c v֧i GIF ֫ 

ch֣ PNG h֣ tr֯ Ӷnh 24 bit v¨ tӴo nԚn trong su֝t kh¹ng rŁng cҼa 

+ TIFF - Tagged- Image File Format 
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DӴng t֓p tin h³nh Ӷnh linh hoӴt ĽҼ֯c sֹ dֱng ֫ tӸt cӶ c§c chҼҺng tr³nh t¹ vԐ, 

hi֓u ch֕nh Ӷnh, d¨n trang h֣ tr֯ 

4. C§c thao t§c di chuyԜn v¨ ph·ng Ӷnh 

 4.1. C§c l֓nh thu, ph·ng Ӷnh 

+  Zoom out : Ctrl + (+) 

+  Zoom in : Ctrl + (-) 

+  Ph·ng to Ӷnh Ľ֟ng th֩i ph·ng to cֹa s֡ file Ӷnh : Ctrl + Alt + (+)  

+  Thu nh֛ Ӷnh Ľ֟ng th֩i thu nh֛ cֹa s֡ file Ӷnh : Ctrl + Alt + (-) 

+  Thu Ӷnh vԚ mֵc Ľ֥ vַa phӶi (Fit on screen) : Ctrl + 0 

+  Thu Ӷnh vԚ 100% Ctrl + Alt + 0 

 4.2.L֓nh cu֥n Ӷnh 

Khi Ľang ֫ dӴng ph·ng l֧n file Ӷnh mu֝n xem Ӷnh ֫ khu vֽc kh§c c· thԜ 

d½ng 2 thanh cu֥n tr°n 2 cӴnh ngang và d֙c cֳa file Ӷnh, hoԊc c· thԜ mҼ֯n c¹ng 

cֱ hand trong khi sֹ dֱng c¹ng cֱ n¨o Ľ· bԄng c§ch giֻu ph²m Spacebar (ph²m 

c§ch) xuӸt hi֓n biԜu tҼ֯ng h³nh b¨n tay cֳa c¹ng cֱ hand, d½ng n· ĽԜ dich 

chuyԜn cֹa s֡ l¨m vi֓c sang khu vֽc kh§c. Sau khi thӶ ph²m Spacebar ra c¹ng cֱ 

tr֫ lӴi c¹ng cֱ hi֓n h¨nh. 

5. C§c chԒ Ľ֥ hiԜn th֗ Ӷnh 

 ņԜ thuԀn ti֓n trong vi֓c ch֕nh sֹa Ӷnh  nhӸn ph²m F ĽԜ thay Ľ֡i c§c chԒ Ľ֥ 

hiԜn th֗ Ӷnh, trong Ľ·: 

- Standard Screen Mode: HiԜn th֗ ti°u chuӼn ( View / Screen Mode / Standard 

Screen Mode )  

- Full Screen Mode With Menu bar: HiԜn th֗ to¨n m¨n h³nh c· menu (View / 

Screen Mode / Full Screen Mode With Menu bar) 

- Full Screen Mode:  HiԜn th֗ to¨n m¨n h³nh kh¹ng c· menu (View / Screen Mode 

/ Full Screen Mode) 
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6. C§c c¹ng cֱ thҼ֩ng d½ng 

 C§c c¹ng cֱ thҼ֩ng d½ng trong photoshop ĽҼ֯c ĽԊt trong h֥p c¹ng cֱ tool 

box(trong menu Window/tools). Sau Ľ©y l¨ h³nh Ӷnh chi tiԒt c§c c¹ng cֱ trong 

photoshop.  
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6.1  Nh·m c¹ng cֱ lֽa tr֙n 

PhӺn quan tr֙ng nhӸt ĽԜ l¨m vi֓c v֧i Photoshop l¨ l¨m thԒ n¨o ĽԜ ch֙n 

ĽҼ֯c m֥t v½ng m¨ bӴn cӺn xֹ lĨ. Khi m֥t v½ng tr°n Ӷnh ĽҼ֯c ch֙n lֽa th³ ch֕ 

phӺn Ľ· ch֗u t§c Ľ֥ng c¸n phӺn kh§c kh¹ng Ӷnh hҼ֫ng. 

6.1.1.Bί c¹ng cλ Marquee(ph²m tͽt M) 

+  C¹ng cֱ Rectangular Marquee: TӴo v½ng 

ch֙n h³nh chֻ nhԀt hoԊc h³nh vuông. 

+  C¹ng cֱ Elip Marquee: TӴo v½ng ch֙n l¨ 

h³nh el²p hoԊc h³nh tr¸n. 

+  Hai c¹ng cֱ Single row Marquee và Single 

Column Marquee ( không có h²m tԂt ), d½ng ĽԜ tӴo v½ng ch֙n c· bԚ d¨y l¨ 1 

pixel v¨ c· bԚ d¨y chӴy su֝t chiԚu d¨i hoԊc chiԚu ngang cֳa file Ӷnh. 

Chú ý : 

  V֧i c¹ng cֱ Rectangular Marquee  và  Elip Marquee, ĽԜ tӴo h³nh vu¹ng 

hoԊc h³nh tr¸n, giֻ ph²m Shift khi k®o chu֥t. 

6.1.2.Bί c¹ng cλ Lasso Tool( ph²m tͽt L) 

Lasso tool c· 3 loӴi kh§c nhau, ĽԜ chuyԜn 

giֻa c§c loӴi lasso click chu֥t phӶi v¨o icon 

tr°n thanh c¹ng cֱ hoԊc d½ng Shift + L.  

  + Lasso tool:  C¹ng cֱ n¨y cho ph®p bӴn k®o 

chu֥t v¨ vԐ th¨nh m֥t h³nh dӴng t½y Ĩ 

mu֝n, khi thӶ chu֥t ra h³nh dӴng Ľ· sԐ tr֫ th¨nh m֥t v½ng ch֙n.  

+ Polygonal Lasso Tool:. C¹ng cֱ n¨y tҼҺng tֽ Lasso tool nhҼng cho ph®p bӴn 

click v¨ thӶ chu֥t ĽԜ tӴo  n°n v½ng ch֙n thay v³ vԐ tֽ do nhҼ tr°n.  

+ Magnetic Lasso Tool:  TӴo v½ng lֽa ch֙n dֽa tr°n bi°n cֳa 2 v½ng màu tách 

bi֓t. C¹ng cֱ n¨y sԐ tֽ Ľ֥ng nhԀn biԒt ĽҼ֯c ĽҼ֩ng bi°n cֳa sֽ t§ch bi֓t m¨u. 

NԒu c· ĽiԜm m֝c n¨o ĽԊt l֓ch v֗ tr², ch֕ cӺn Ӹn ph²m Delete ĽԜ x·a ĽiԜm m֝c 

Ľ· v¨ quay lӴi. ֪ tr°n thanh t½y ch֙n c§c bӴn c· thԜ ĽiԚu ch֕nh mֵc Ľ֥ nhӴy 

cֳa c¹ng cֱ n¨y.  

6.1.3.C¹ng cλ Magic wand tool(ph²m tͽt W) 

C¹ng cֱ n¨y ch֙n v½ng ch֙n dֽa theo m¨u sԂc. Click chu֥t v¨o m֥t v½ng 

bӸt k³ tr°n vŁn bӶn Ӷnh, Magic wand sԐ tֽ Ľ֥ng ch֙n v½ng ch֙n c· m¨u sԂc tҼҺng 

tֽ xung quanh Ľ·: 
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 Khi ch֙n magic wand, c§c bӴn sԐ  thӸy thanh t½y ch֙n nhҼ dҼ֧i: 

 

Trong Ľ· th¹ng s֝ Tolerance c· thԜ coi l¨ Ľ֥ nhӴy cֳa magic wand, nԒu bӴn 

b֛ lֽa ch֙n ô Contigious, magic wand sԐ ch֙n tӸt cӶ khu vֽc m¨u tҼҺng tֽ trong 

h³nh thay v³ ch֕ v½ng ĽҼ֯c click: 

6.1.4.Các t½y chΣn cho v½ng trΣn 

M֥t khi Ľ« c· v½ng ch֙n, bӴn c· thԜ v¨o Select -> Modify ĽԜ thay Ľ֡i v½ng 

ch֙n v֧i nhֻng t½y ch֙n c· sԈn: 

o Border sԐ tӴo ra v½ng ch֙n dӴng ĽҼ֩ng viԚn. 

o Smooth sԐ l¨m tr¸n c§c g·c cֳa v½ng ch֙n. 

o Expand sԐ m֫ r֥ng v½ng ch֙n 

o Contract sԐ thu nh֛ v½ng ch֙n 

o Feather sԐ b¹i nh¸e m®p cֳa v½ng ch֙n ĽԜ khi cԂt h³nh ra m®p mҼ֯t và 

kh¹ng b֗ gai. 

Ngoài ra, dҼ֧i mֱc Select bӴn cȈng c· thԜ ch֙n: 

o Grow ĽԜ v½ng ch֙n tֽ Ľ֥ng m֫ r֥ng ra v½ng c· m¨u sԂc tҼҺng tֽ 

o Smilar ĽԜ v½ng ch֙n m֫ r֥ng ra tӸt cӶ nhֻng v½ng c· m¨u sԂc tҼҺng tֽ tr°n 

vŁn bӶn Ӷnh. 

Chú ý:  

NԒu mu֝n b֛ v½ng lֽa ch֙n: Ch֙n menu select/Deselect(ctrl + D) 

6.1.5.Ghi nhα v½ng chΣn 

GiӶ sֹ ch¼ng ta Ľ« mӸt rӸt 

nhiԚu c¹ng sֵc ĽԜ tӴo ĽҼ֯c m֥t 

v½ng ch֙n phֵc tӴp v¨ ch²nh x§c. 

GiӶ sֹ t¹i bԀn vi֓c g³ Ľ· kh¹ng thԜ 

tiԒp tֱc l¨m vi֓c, nhҼng lӺn sau 

quay lӴi t¹i kh¹ng mu֝n phӶi mӸt 

c¹ng ng֟i t֕ m ֕tӴo lӴi vùng ch֙ n 

nֻa. RӸt ĽҺn giӶn, khi Ľ« c· v½ng 

ch֙n Ҽng Ĩ, ch¼ng ta c· thԜ lҼu 

v½ng ch֙n Ľ· lӴi bԄng c§ch 

vào Select -> Save Selection. 
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BӴn c· thԜ ĽԊt t°n cho v½ng ch֙n 

tr֙ng mֱc name v¨ nhӸn OK.  

M֥t Ľ« ghi nh֧ v½ng ch֙n, bӴn 

c· thԜ y°n t©m Ľi Ľ©u Ľ· kh§c, lӺn 

sau khi quay tr֫ lӴi, m֫ file ra, bӴn 

ch֕ cӺn v¨oSelect -> Load 

Selection, ch֙n t°n v½ng ch֙n vַa 

lҼu trong Channel, v¨ bӴn sԐ c· lӴi 

v½ng ch֙n ho¨n hӶo cֳa m³nh. 

 

 

Chú ý : 

T½y ch֙n Invert cho ph®p tӶi v½ng ch֙n dҼ֧i dӴng ngh֗ch ĽӶo 

6.2 C¹ng cֱ Crop(ph²m tԂt C)  

- C¹ng dֱng : D½ng ĽԜ cԂt ( x®n ) Ӷnh. 

- Thao t§c : D½ng c¹ng cֱ Crop ĽԜ vԐ ra 1 v½ng ch֙n c· dӴng 1 khung h֥p bao 

quanh khu vֽc Ӷnh cӺn giֻ lӴi (khung h֥p n¨y c· 8 n¼t ĽiԚu khiԜn ֫ 4 cӴnh 

v¨ 4 g·c, c· thԜ ĽiԚu ch֕nh lӴi v½ng ch֙n bԄng c§c n¼t ĽiԚu khi°n n¨y) PhӺn 

Ӷnh kh¹ng nԄm trong khung h֥p n¨y sԐ b֗ loӴi b֛ v¨ file Ӷnh sԐ c· k²ch thҼ֧c 

m֧i bԄng k²ch thҼ֧c cֳa khung h֥p n¨y. 

 

PhӺn Ӷnh ĽҼ֯c 

giֻ lӴi 

PhӺn Ӷnh b֗ loӴi 

b ֛
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Hinh Ӷnh thanh tuȢ ch֙n cֳa c¹ng cֱ Crop : 

 

     Trong Ľ·: 

+ Width : NhԀp Ľ֥ r֥ng cֳa khung cӺn cԂt . 

+ Height : NhԀp chiԚu cao cֳa khung cӺn cԂt .   

+ Resolution : NhԀp Ľ֥ ph©n giӶi cho Ӷnh sau khi cԂt 

+ N¼t Front Image : LӸy k²ch thҼ֧c cӺn cԂt bԄng k²ch thҼ֧c cֳa file Ӷnh. 

6.3  C¹ng cֱ Eraser(E) 

Công c ֱxóa Eraser Tool sԐ làm thay Ľ֡i nhֻng pixels khi bӴn rê chu֥t trên 

file Ӷnh. NԒu bӴn Ľang làm vi֓c trên l֧p background hoԊc trên m֥t layer nào Ľ· 

mà chֵc nŁng Transperancy locked  Ľang ĽҼ֯c ch֙n thì nhֻng 

pixels trong vùng bӴn mu֝n xóa sԐ thay Ľ֡i thành màu background,ngҼ֯c lӴi 

nhֻng pixels b ֗xóa sԐ tr֫ thành trong su֝t. 

Ch֙n công c ֱEraser trên thanh công cֱ.  Thֽc hi֓n nhֻng vi֓c sau trên thanh 

tùy ch֙n. 

 

o Ch֙n m֥t nét c ֙và nhֻng tùy ch֙n cho nét c ֙trong tùy ch֙n Brush (A). 

o Ch֙n loӴi c ֙(brush,pencil hay block) trong tùy ch֙n mode (B). 

o Ch֕ Ľ֗nh m֥t Opacity (C)cho công c ֱxóa.Opacity 100% thì các pixels sԐ b ֗

xóa hoàn to¨n,mֵc opacity nh֛ hҺn sԐ xóa 1 phӺn. 

o Tùy ch֙n (D) có chֵc nŁng nhҼ m֥t c ֙phun. 

o Eraser to history (E): NԒu ch֙n mֱc này thì khi xóa sԐ khôi phֱc lӴi m֥t 

trӴng thái history (bӴn phӶi ch֙n m֥t trӴng thái trong palette history, nԒu 

không sԐ dùng trӴng thái mԊc Ľ֗nh). 

- Công c ֱBackground Eraser Tool (E):  

Công c ֱnày sԐ xóa pixels trên m֥t layer,vùng b ֗xóa tr֫ thành trong su֝t. 

Thông s ֝Tolerance và các tùy ch֙n sambling (Ľ§nh dӸu A,B và C trong hình 

minh h֙a) trên thanh tùy ch֙n sԐ quyԒt Ľ֗nh s ֝pixels ĽҼ֯c xóa. 

 

 

http://2.bp.blogspot.com/_8tM_FVaOl98/SfVVBznzMUI/AAAAAAAABBU/XkcFMS9EPZA/s1600-h/hinh-a.gif
http://2.bp.blogspot.com/_8tM_FVaOl98/SfVU1SpBrLI/AAAAAAAABBE/jFTJdrv5RaA/s1600-h/hinh-3.gif
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  A-Xóa pixels trong khi rê chu֥t.  

  B-Ch֕ xóa nhֻng vùng có màu tҼҺng t ֽv֧i màu tӴi v ֗trí kích 

chu֥t lӺn ĽӺu tiên. 

  C-Ch֕ xóa nhֻng vùng có màu tҼҺng t ֽmàu background hi֓n 

hành. NԒu ch֙n Protect Foreground Color sԐ không xóa nhֻng màu gi֝ng màu 

Foreground. 

- Công c ֱMagic Eraser Tool (E):  

Khi bӴn kích ch֙n vào m֥t layer bԄng công c ֱnày, sԐ t ֽĽ֥ng làm thay Ľ֡i 

tӸt cӶ các pixels tҼҺng t ֽcŁn c ֵvào thông s ֝Tolerance. 

 

Tùy ch֙n Contiguous:nԒu ch֙n thì ch֕ xóa pixels trong "vùng lân cԀn",nԒu 

không ch֙n thì sԐ xóa trong toàn b ֥file Ӷnh. 

Tùy ch֙n Sample All  Layers: nԒu ch֙n thì sԐ xóa trên toàn b ֥ layer Ľang 

hiԜn th֗,kh¹ng ch֙n thì ch֕ xóa trên layer hi֓n hành. 

Tùy ch֙n Opacity : NԒu Opacity 100% sԐ xóa" hoàn toàn", m֥t giá tr֗ 

Opacity nh֛ hҺn sԐ xóa "1 phӺn". 

6.4  C¹ng cֱ Move(V)  

D½ng ĽԜ di chuyԜn Ľ֝i tҼ֯ng trong file Ӷnh tַ v֗ tr² n¨y sang v֗ tr² kh§c. NhӸp 

ch֙n biԜu tҼ֯ng cֳa c¹ng cֱ tr°n thanh c¹ng cֱ hoԊc bӸm ph²m V tr°n b¨n ph²m 

sau Ľ· bӸm v¨o Ľ֝i tҼ֯ng v¨ r° sang v֗ tr² kh§c (bӸm v¨ giֻ chu֥t trong khi r°). 

LҼu Ĩ : 

- ņԜ di chuyԜn Ľ֝i tҼ֯ng,trҼ֧c ti°n ch¼ng ta phӶi ch֙n layer chֵa Ľ֝i tҼ֯ng Ľ·. 

- Khi ch֙n c¹ng cֱ Move, nԒu ch֙n chֵc nŁng Auto select layer trên thanh tùy 

ch֙n,sԐ tֽ Ľ֥ng ch֙n Layer tӴi v֗ tr² click chu֥t. 

 M֥t s֝ thu֥c t²nh kh§c: 

o Show Bounding Box: HiԜn th֗ t§m n֝t xung quanh Ľ֝i tҼ֯ng, ta c· thԜ xoay, 

co gi«n,é 

o Nhóm Align : D½ng ĽԜ gi·ng h¨ng c§c Layer ĽҼ֯c li°n kԒt (link) 

v֧i nhau. 

o Nhóm Distribute : D½ng ĽԜ ph©n ph֝i ĽԚu c§c Ľ֝i tҼ֯ng ĽҼ֯c li°n kԒt 

v֧i nhau. 

http://2.bp.blogspot.com/_8tM_FVaOl98/SfVU1gykR6I/AAAAAAAABBM/qnQTQg1wSkg/s1600-h/hinh-4.gif
http://1.bp.blogspot.com/_8tM_FVaOl98/SfVXtnN321I/AAAAAAAABB0/ae7p9b30j8k/s1600-h/hinh-5.gif
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6.5  C¹ng cֱ  Eyedropper (I)  

Khi bӴn không biԒt r» ĽҼc֯ giá tr֗ c aֳ m֥ t m¨u n¨o Ľ·, m¨ bӴn thích và 

mu֝ n sֹ  d nֱg m¨u Ľ·. Ta c· thԜ ch֙ n công cֱ  Eye Dropper ĽԜ lӸy mӾu màu. 

Công c ֱnày lӸy m֥t mӾu màu ĽԜ tӴo màu m֧i cho hôp màu Foreground hoԊc 

background. BӴn có thԜ lӸy mӾu màu trên file Ӷnh hi֓n hành hay bӸt kȢ v ֗trí nào 

trên màn hình làm vi֓c.  

ņԜ thay Ľ֡i kích thҼ֧c mӾu, ch֙n 1 tùy ch֙n trong mֱc sample size trên thanh 

tùy ch֙n. 

6.6.Công cλ Color Sampler Tool (I):   

Công c ֱnày dùng ĽԜ ñĽ§nh dӸuò v ֗trí cӺn lӸy mӾu màu. Ch֙n công cֱ, click 

lên file Ӷnh nҺi cӺn lӸy mӾu,m֥t nút tròn sԐ xuӸt hi֓n Ľ§nh dӸu v ֗trí Ľ· và ngay lԀp 

tֵc Panel Info sԐ bung ra cho ta biԒt thông s ֝màu tӴi v ֗trí bӴn Ľ« Ľ§nh dӸu.BӴn có 

thԜ ch֙n t֝i Ľa 4 nút trên file Ӷnh.  

 

 

6.7 Reset c¹ng cֱ 

NԒu nhҼ c· m֥t c¹ng cֱ hoӴt Ľ֥ng kh¹ng nhҼ  ý 

mu֝n cֳa bӴn, rӸt c· thԜ v³ bӴn Ľ« thay Ľ֡i g³ Ľ· trong 

t½y ch֙n cֳa c¹ng cֱ Ľ·. M֥t khi nhֻng t½y ch֙n n¨y 

b֗ thay Ľ֡i, PS sԐ giֻ nguy°n nhֻng thay Ľ֡i Ľ·. NԒu 

bӴn kh¹ng chԂc, c§ch t֝t nhӸt l¨ reset lӴi c¹ng cֱ. Click 

chu֥t phӶi v¨o icon cֳa c¹ng cֱ tr°n thanh t½y ch֙n: 

http://1.bp.blogspot.com/_8tM_FVaOl98/ShAEN7_jI9I/AAAAAAAABq4/1tq2wZFsEOs/s1600-h/eyedropper.gif
http://3.bp.blogspot.com/_8tM_FVaOl98/ShAENxatl5I/AAAAAAAABqw/BWBa0UftryY/s1600-h/color-sampler.gif
http://hocps.files.wordpress.com/2008/07/reset-tool.jpg
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Ch֙n Reset tool sԐ khiԒn cho c§c t½y ch֙n tr֫ vԚ mԊc Ľ֗nh ban ĽӺu cֳa PS. 

Ch֙ n Reset All Tools sԐ reset to¨n b֥ c§c c¹ng cֱ trong tools bar. 

 

7. C§c thao t§c xoay Ӷnh 

7.1.LΜnh Free Transform 

Ch֙n layer mu֝n xoay r֟i ch֙n  Edit / Free 

Transform(Ctrl + T) xoay Ӷnh ĽԒn v֗ tr² mong mu֝n r֟i 

nhӸn Enter ĽԜ s§c nhԀn sֽ thay Ľ֡i. 

Chú ý:  C· thԜ thֽc hi֓n ph·ng to, thu nh֛ Ӷnh bԄng l֓nh 

Transfrom. Trong qu§ tr³nh thay Ľ֡i k²ch thҼ֧c nhӸn 

ph²m Shift ĽԎ giֻ nguy°n t֕ l֓ Ӷnh. 

7.2.C§c lΜnh Transform kh§c 

+ BӸm ch֙n l֧p Ӷnh hoԊc v½ng Ӷnh tr°n l֧p cӺn hi֓u ch֕nh 

+ Ch֙n Edit->Transform sԐ cho c§c lֽa ch֙n hi֓u ch֕nh sau: 

       - Scale                Ph·ng to, thu nh֛ Ӷnh ch֙n 

       - Rotate              Xoay v½ng Ӷnh ch֙n 

       - Skew                K®o x¹ Ӷnh 

       - Distort             B·p m®o Ӷnh 

       - Perspective         B·p m®o Ӷnh Ľ֝i xֵng (Sau khi chΣn mίt trong sΧ c§c 

chοc   nŁng tr°n, bͫm k®o chuίt tͧi c§c ĽiΘm g·c ͩnh 

ĽΘ hiΜu chΞnh cho ph½ hιp) 

        - Numeric            Hi֓u ch֕nh k²ch c֭ v¨ xoay Ӷnh bԄng gi§ tr֗ thֽc 

(nhͻp v¨o gi§ trΠ ph·ng to, thu nhΥ hoΊc g·c xoay ͩnh) 

        - Rotate 1800       Xoay Ӷnh ch֙n 1800 

        - Rotate 900 CW    Xoay Ӷnh 900 ngҼ֯c chiԚu kim Ľ֟ng h֟ 

        - Rotate 900 CCW       Xoay Ӷnh 900 xu¹i chiԚu kim Ľ֟ng h֟ 

        - Flip Horizontal  LԀt Ӷnh theo chiԚu ngang 

        - Flip Vertical       LԀt Ӷnh theo chiԚu d֙c 
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Bài 2 

CÁC L֒NH Xָ Lħ VĒNG CH֘N 

 

1. L֓nh thao t§c v½ng ch֙n 

1.1.VΒ th°m v½ng chΣn 

 Ch֙n c¹ng cֱ add to selection tr°n thanh thu֥c t²nh  cֳa c¹ng cֱ lֽa ch֙n. 

khi bӴn nhӸp v¨o Ľ©y th³ khi lֽa ch֙n 1 v½ng ch֙n v¨ ch֙n tiԒp v½ng ch֙n thֵ 

hai th³ v½ng ch֙n thֵ 2 n¨y sԐ thêm v¨o v½ng ch֙n thֵ nhӸt l¨m cho v½ng ch֙n  

ng¨y c¨ng m֫ r֥ng bao g֟m cӶ v½ng ch֙n thֵ nhӸt v¨ v½ng ch֙n thֵ 2 ( bӴn c· 

thԜ giֻ Shift sau khi ch֙n 1 v½ng ch֙n ĽԜ m֫ r֥ng v½ng ch֙n m¨ ko cӺn nhӸp 

lֽa ch֙n n¨y). 

 

1.2.Loͧi trρ bαt v½ng chΣn 

 Ch֙n c¹ng cֱ suptract from selection  tr°n thanh thu֥c t²nh  cֳa c¹ng cֱ lֽa 

ch֙n. khi bӴn nhӸp v¨o Ľ©y th³ khi lֽa ch֙n 1 v½ng ch֙n v¨ ch֙n tiԒp v½ng ch֙n 

thֵ hai th³ v½ng ch֙n thֵ 1 n¨y sԐ mӸt Ľi m֥t phӺn bԄng v½ng ch֙n thֵ 2 ( bӴn 

c· thԜ giֻ Alt sau khi ch֙n 1 v½ng ch֙n ĽԜ m֫ r֥ng v½ng ch֙n m¨ ko cӺn nhӸp 

lֽa ch֙n n¨y). 

 

1.3.LΜnh Selecl All 

 Khi mu֝n lֽa ch֙n tӸt cӶ v½ng Ӷnh ch֙n Select / All(Ctrl + A) 

1.4.LӸy phӺn giao cֳa hai vùng ch֙n (intersection):  

GiӶ sֹ bӴn Ľ« c· m֥t v½ng ch֙n. NhӸn giֻ ph²m Alt  + Shift , r֟i tӴo m֥t 

v½ng ch֙n m֧i (bԄng m֥t trong c§c c¹ng cֱ tӴo v½ng ch֙n) ĽԜ lӸy phӺn giao 
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cֳa hai v½ng ch֙n. ņԜ Ĩ rԄng c· m֥t dӸu nh©n (X) xuӸt hi֓n cӴnh b°n con tr֛ 

khi bӴn vԐ. 

 

1.5. ņӶo ngҼ֯c v½ng tr֙n 

 Khi c· m֥t v½ng lֽa ch֙n nԒu mu֝n chuyԜn v½ng Ľ« lֽa ch֙n th¨nh v½ng 

kh¹ng ĽҼ֯c lֽa ch֙n v¨ ngҼ֯c lӴi v½ng kh¹ng ĽҼ֯c lֽa ch֙n tr֫ th¨nh v½ng lֽa 

ch֙n th³ d½ng l֓nh inverse bԄng c§ch ch֙n menu Select/inverse (Shift + Ctrl + I) 

 

1.6. Hֳy b֛ v½ng tr֙n 

Khi c· m֥t v½ng ch֙n nԒu mu֝n hֳy b֛ v½ng ch֙n ta d½ng l֓nh Deselect, 

trong menu ch֙n Select/ Deselect(Ctrl + D). 

-  Ph·ng to thu nh֛ v½ng ch֙n 

 Khi mu֝n thay Ľ֡i kh²ch thҼ֧c v½ng ch֙n ta d½ng l֓nh Transform Selection, 

trong menu ch֙n Slect/ Transform Selection. Giֻ ph²m Shift v¨ bӸm v¨o m֥t 

trong 4 n¼t vu¹ng v½ng ch֙n sԐ ĽԚu hҺn hoԊc c· thԜ click phӶi chu֥t v¨o b°n 

trong v½ng ch֙n ĽԜ ch֙n chԒ Ľ֥ Transform Selection. 

-  C§c l֓nh Modify 

Vào Select > Modify : C§c l֓nh Modify d½ng ĽԜ sֹa Ľ֡i v½ng ch֙n v֧i c§c lֽa 

ch֙n 

LΜnh Border : Sֹa Ľ֡i v½ng ch֙n hi֓n h¨nh th¨nh v½ng ch֙n c· dӴng khung 

viԚn. NhԀp Ľ֥ d¨y ĽҼ֩ng viԚn trong mֱc Width sau Ľ· nhӸn OK.  
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LΜnh Smooth : L¨m mԚm c§c g·c nh֙n cֳa v½ng ch֙n. nhԀp s֝ lҼ֯ng pixels 

trong mֱc Sample Radius. R֟i nhӸn ok x§c nhԀn sֽ thay Ľ֡i. 

 

   LΜnh Expand : M֫ r֥ng di֓n t²ch v½ng ch֙n 

           

LΜnh Contract : Thu hԌp di֓n t²ch v½ng ch֙n 

 

1.7. Kh¹i phֱc lӴi v½ng tr֙n (Reselect) 

Khi s·a b֛ m֥t v½ng tr֙n, mu֝n kh¹i phֱc lӴi v½ng tr֙n vַa x·a b֛,Trên thanh 

menu ch֙n Select/Reselect(Shift + Ctrl + D) 

1.8. Sao chép v½ng tr֙n 

Lֽa ch֙n v½ng Ӷnh cӺn sao ch®p, sau Ľ· ch֙n menu Edit/ copy (Ctrl + C) 

1.8.1. D§n nhֻng ĽiԜm Ӷnh Ľ« ĽҼ֯c sao ch®p 

Sau khi Ľ« sao ch®p song v½ng Ӷnh ĽԜ d§n v½ng Ӷnh Ľ« ĽҼ֯c sao ch®p ch֙n 

menu Edit/ Paste (Ctrl + V) 

1.8.2.Ch֙n to¨n b֥ c§c ĽiԜm Ӷnh tr°n 1 layer 



Gi§o tr³nh m¹n: ņ֟ h֙a ֵng dֱng        TrҼ֩ng Cao ņԆng NghԚ Y°n Bái 
  

20 

 

ņԜ ch֙n lֽa tӸt cӶ c§c pixel (ĽiԜm Ӷnh) kh¹ng trong su֝t tr°n m֥t layer 

(ngҼ֯c v֧i vi֓c sֹ dֱng "Select All" l¨ ch֙n lֽa to¨n b֥ layer), bӴn h«y giֻ 

phím Control (Windows) hoԊc ph²m Command (Mac), r֟i click tr°n layer Ľ· 

trong bӶng Layers Palette: 

1.8.3.Xo§ to¨n b֥ ĽiԜm Ӷnh tr°n v½ng ch֙n 

Ch֙n v½ng Ӷnh mu֝n s·a, sau Ľ· ch֙n Edit/clear hoԊc nhӸn ph²m Delete 

trên bàn phím 

2. M  ֫r֥ng(thay Ľ֡i) vùng ch֙n dֽa v¨o mӺu sԂc 

- L֓nh Color range 

Ch¼ng ta c· thԜ ch֙n m֥t m¨u hay m֥t d«y m¨u Ľ« ĽҼ֯c ch֕ Ľ֗nh hoԊc m֥t s֝ 

"m¨u chuӼn" trong phӴm vi m֥t v½ng ch֙n cho trҼ֧c hoԊc tr°n to¨n bֵc Ӷnh 

th¹ng qua l֓nh Color Range, l֓nh kh¹ng c· hi֓u lֽc Ľ֝i v֧i nhֻng bֵc Ӷnh c· 

32 bit màu / kênh. 

ņԜ sֹ dֱng l֓nh ch¼ng ta v¨o Menu Select \ Color Range sԐ xuӸt hi֓n h֥p thoӴi 

nhҼ sau: 

 

 
Trong menu Select cֳa h֥p thoӴi Color Range nԒu ta ch֙n: 

¶ Sample Color :Khi di chu֥t l°n tr°n file Ӷnh sԐ tֽ Ľ֥ng chuyԜn sang c¹ng 

cֱ Eye Dropper ,ch¼ng ta click chu֥t l°n file Ӷnh tӴi v½ng m¨u mu֝n 

ch֙n ĽԜ x§c lԀp m¨u.  

¶ Thanh trҼ֯t Fuzziness : Mֵc Ľ֥ nhԀn biԒt Thao t¹ng m¨u tҼҺng Ľ֟ng. 

¶  C¹ng cֱ Eyedroper : Ch֕ Ľ֗nh t¹ng m¨u ĽӺu ti°n ĽҼ֯c ch֙n. 

http://4.bp.blogspot.com/_8tM_FVaOl98/SuGmaWpbE1I/AAAAAAAADW0/JdIYNfGqWvU/s1600-h/icon1.gif
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¶  C¹ng cֱ Add to Sample : Ch֕ Ľ֗nh th°m t¹ng m¨u cӺn ch֙n. 

¶ C¹ng cֱ Subtract from Sample : LoӴi b֧t t¹ng m¨u Ľ« ch֙n. 

¶  TuȢ ch֙n Invert : Cho ph®p ĽӶo ngҼ֯c v½ng ch֙n 

¶ Mֱc Selection Preview : C§ch hiԜn th֗ v½ng ch֙n tr°n file Ӷnh, thҼ֩ng ĽԜ 

None 

- LΜnh Grow 

C¹ng dֱng : M֫ r֥ng v½ng ch֙n ra nhֻng v½ng c· m¨u tҼҺng Ľ֟ng v֧i m¨u 

cֳa v½ng ch֙n hi֓n h¨nh .  

- LΜnh Similar 

D¸ t³m tr°n to¨n b֥ file tӸt cӶ c§c mӾu m¨u tr½ng v֧i m¨u bӴn Ľ« ch֙n trҼ֧c Ľ· 

v¨ ch֙n hԒt to¨n b֥ file theo t¹ng m¨u Ľ·. 

3. T¹ m¨u cho Ľ֝i tҼ֯ng 

C§c kiԜu t¹ m¨u cho Ľ֝i tҼ֯ng bao g֟m t¹ m¨u tiԚn cӶnh v¨ hԀu cӶnh hoԊc sֹ 

dֱng c§c l֓nh Fill, Strocke. C§c l֓nh n¨y d½ng ĽԜ t¹ m¨u phԆng cho v½ng. NԒu 

kh¹ng c· v½ng ch֙n, th³ sԐ t¹ m¨u cho to¨n b֥ Layer hi֓n h¨nh. 

3.1.Tô M¨u tiΖn cͩnh, m¨u hͻu cͩnh 

MԊc Ľ֗nh m¨u cֳa tiԚn cӶnh l¨ m¨u Ľen, c¸n m¨u hԀu cӶnh l¨ 

m¨u trԂng. ņԜ thay Ľ֡i m¨u mԊc Ľ֗nh, ta k²ch chu֥t v¨o tַng ¹ m¨u 

ĽԜ thay Ľ֡i . Mu֝n tr֫ vԚ m¨u mԊc Ľ֗nh, nhӸn ph²m D v¨ ĽԜ thay Ľ֡i 

qua lӴi giֻa 2 m¨u, nhӸn ph²mX . 

ņԜ t¹ m¨u tiԚn cӶnh nhӸn  Alt + Delete hoԊc  Alt + Backscape  

ņԜ T¹ m¨u hԀu cӶnh nhӸn Ctrl + Delete hoԊc Ctrl +Backscape 

3.2.LΜnh Fill  

Fill l¨ chֵc nŁng cho ph®p ch¼ng ta 

t¹ m¨u Ľ֟ng nhӸt cho m֥t v½ng ch֙n 

tr°n Ӷnh hay to¨n b֥ l֧p ĽҼ֯c ch֙n. 

o ÐҼn֩g dӾn: Menu Edit/ Fill 

hoԊc: Shift + F5 hoԊc Shift + Backscape 

o C¹ng dֱng: T¹ m¨u phԆng nhҼng 

c· thiԒt lԀp c§c thu֥c t²nh cho m¨u 

ĽҼ֯c t¹ . 

BӶng thoӴi Fill: BӶng n¨y c· c§c mֱc: 
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o Use: Lֽa ch֙n h֥p m¨u d½ng ĽԜ t¹ 

o Pattern: L¨ h֥p chֵa nhֻng pattern  (mӾu hình). Mֱc n¨y sԐ xuӸt hi֓n khi 

lֽa ch֙n h֥p m¨u Pattern ֫ mֱc Use.  

+ Mode: ChԒ Ľ֥ ho¨ tr֥n  

+ Opacity: ņ֥ m֩ Ľֱc.  

TuȢ ch֙n Preserve Transparent: BӶo to¨n t²nh trong su֝t cֳa l֧p (ch֕ t¹ v¨o 

khu vֽc c· ĽiԜm Ӷnh) 

3.3.LΜnh Stroke 

ĥҼ֩ng dӾn: menu Edit/ Stoke 

C¹ng dֱng: T¹ m¨u cho ĽҼ֩ng viԚn cֳa v½ng ch֙n. 

BӶng thoӴi Stoke: 

+ Stoke: T²nh chӸt cֳa ĽҼ֩ng viԚn  

Mֱc With: NhԀp gi§ tr֗ bԚ dӺy 

choņҼ֩ng viԚn. 

Mֱc Color: Ch֙n m¨u cho ĽҼ֩ng viԚn 

+ Location: V֗ tr² cֳa ĽҼ֩ng viԚn so v֧i 

biên v½ng ch֙n 

Inside: Bên trong 

Center: giֻa 

Outside: Bên ngoài 

+ Blending: Lֽa ch֙n chԒ Ľ ֥hoà tr֥n v¨ m֩ Ľֱ c. 

- C¹ng cλ Gradient tool (G) 

Gadient Tool l¨ c¹ng cֱ cho ph®p ch¼ng ta t¹ m¨u chuyԜn sԂc cho v½ng ch֙n 

hay l֧p dֽa tr°n kiԜu m¨u c· sԈn hay thiԒt lԀp m¨u m֧i. 

Thao t§c thֽc hi֓n:  K²ch ĽiԜm ĽӺu v¨ 

r° chu֥t t֧i m֥t ĽiԜm cu֝i bӸt kȢ (BӸm giֻ 

Shift trong khi r° mouse nԒu mu֝n t¹ theo 1 

ĽҼ֩ng thԆng). 

C§c lֽa ch֙n kiԜu chuyԜn sԂc: 
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o Linear Gradient: M¨u biԒn thi°n tַ ĽiԜm ĽӺu ĽԒn ĽiԜm cu֝i theo ĽҼ֩ng 

thԆng. 

o Radial Gradient: M¨u biԒn thi°n tַ ĽiԜm ĽӺu ĽԒn ĽiԜm cu֝i theo dӴng t֛a 

tròn. 

o Angle Gradient:  M¨u biԒn thi°n ngh֗ch chiԚu kim Ľ֟ng h֟ xung quanh ĽiԜm 

bԂt ĽӺu (gi֝ng h³nh ch·p hay h³nh n·n). 

o Reflect Gradient:  M¨u biԒn thi°n dֽa tr°n mӾu gradient tuyԒn t²nh Ľ֝i xֵng 

֫ m֥t b°n ĽiԜm bԂt ĽӺu. 

o Diamond Gradient:  m¨u biԒn thi°n tַ ĽiԜm bԂt ĽӺu hҼ֧ng ra ngo¨i theo dӴng 

h³nh thoi. ņiԜm cu֝i quyԒt Ľ֗nh m֥t g·c cֳa h³nh thoi. 

MԊt kh§c, ta c· thԜ t½y ch֙n c§ch chuyԜn sԂc trong bӶng Gradient Options 

 

- Blending mode: C§c chԒ Ľ֥ h¸a tr֥n 

- Opacity: Ľ֥ trong su֝t 

- Gradient: c§c lֽa ch֙n gradient kh§c nhau 

- Transparency: cho ph®p t¹ kiԜu Gradient trong su֝t 

- Dither: tӴo mӾu h¸a tr֥n m֗n hҺn, ²t s֙c hҺn. ֪ chԒ Ľ֥ mԊc Ľ֗nh (tֽ Ľ֥ng m¹ 
ph֛ng nhֻng m¨u kh¹ng thԜ hiԜn th֗ ĽҼ֯c tr°n m§y). 

- Reverse: v֧i t½y ch֙n n¨y, m¨u Gradient ĽҼ֯c tӴo ra sԐ b֗ ĽӶo ngҼ֯c v֗ tr² so 
v֧i m¨u Ľ« ch֙n. 

Click to Edit the 

Gradient ( ): 

nhӸp v¨o n¼t n¨y ĽԜ m֫ 

Gradient Editor, d½ng ĽԜ 

ch֕nh sֹa t²nh chӸt cֳa 

m¨u Gradient Ľang ĽҼ֯c 

ch֙n. S ֹ dֱng bӶng 

Gradient Editor ĽԜ thay 

Ľ֡i m¨u t¹ chuyԜn theo 

nhֻng g·c Ľ֥ kh§c nhau. 

- Th°m m֥t n¼t m¨u tr°n 
d«y chuyԜn sԂc: k²ch 1 

lӺn v¨o 1 ĽiԜm bӸt kȢ 
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ngang h¨ng v֧i c§c n¼t Color Stop 

- ņ֡i m¨u: double click l°n n¼t m¨u cӺn Ľ֡i 

- X·a n¼t m¨u: ch֙n n¼t m¨u cӺn xóa Ą k²ch n¼t Delete ph²a dҼ֧i bӶng 

Gradient Editor hay ch֕ cӺn k®o drag n¼t m¨u xu֝ng dҼ֧i kh֛i thanh m¨u. 

- Load thҼ vi֓n gradient: k²ch v¨o menu palette Gradient Editor\ ch֙n thҼ vi֓n 

cӺn Load. 

- LӸy lӴi thҼ vi֓n mԊc Ľ֗nh: k²ch v¨o menu palette Gradient Editor\ Preset 

Gradientsé 

- C¹ng cλ Paint Bucket: 

C¹ng dֱng: T¹ m¨u cho nhֻng v½ng c· m¨u tҼҺng Ľ֟ng v֧i nhau. 

 

 TuȢ ch֙n: 

+ Fill: Lֽa ch֙n m¨u foreground hay Pattern ĽԜ t¹. 

+ Pattern: Lֽa ch֙n mӾu Pattern (NԒu mֱc Fill ta ch֙n h֥p m¨u l¨ pattern) 

Còn các tuȢ ch֙n kh§c gi֝ng c¹ng cֱ Magic Erase . 

- T¹ m¨u theo m͵u t¹ Pattern 

T¹ m¨u theo mӾu Pattern l¨ Ćp dֱng  hoӴ tiԒt l°n Ľ֝i tҼ֯ng v֧i nhֻng mӾu Ӷnh 

c· sԈn 

- C§ch tӴo mӾu t¹ Pattern  

B1. TӴo Ľ֝i tҼ֯ng d½ng ĽԜ tӴo mӾu t¹ 

 

B2. NhӸn Ctrl + A (ch֙n hԒt Ӷnh) hoԊc ch֙n m֥t v½ng ch֙n bӸt kȢ tr°n mӾu 

Ch֙n Edit \ Define Pattern (ĽԊt t°n mӾu t¹ -> OK) 
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- T¹ m¨u theo mӾu t¹ 

B1. Lֽa ch֙n m֥t v½ng Ӷnh, hoԊc m֥t 

layer cӺn t¹. 

B2. Ch֙n Edit \ Fill  

Ch֙n c§c chֵc nŁng trong h֥p thoӴi 

Fill  

- Use: Ch֙n Pattern 

- Custom Pattern: Ch֙n kiԜu 

mӾu t¹ 

- Mode: ChԒ Ľ֥ h¸a tr֥n 

(Normal) 

- Opacity: ņ֥ m֩ 

B3. NhӸp OK MӾu t¹ sԐ ĽҼ֯c t¹ tr°n Ľ֝i tҼ֯ng lֽa ch֙n. 

 

4. T§ch Ľ֝i tҼ֯ng bԄng phҼҺng ph§p Extract  

 

ņҼ֩ng dӾn : menu Filter/ Extract hoԊc g» : Ctrl + Alt + X 

C¹ng dֱng: Tr²ch xuӸt nhֻng h³nh Ӷnh phֵc tӴp c· bi°n kh¹ng r» r¨ng b֗ 

xen kԐ v֧i nԚn. ņԊc bi֓t hֻu ²ch khi v½ng Ӷnh c· dӴng s֯i nh֛(m§i t·c, t¨u l§ 

dַaé).   
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BӶng Extract c· c§c c¹ng cֱ nԄm b°n lԚ tr§i v¨ c§c tuȢ ch֙n nԄm b°n phӶi, ֫ 

giֻa bӶng l¨ h³nh Ӷnh xem trҼ֧c cֳa file Ӷnh . 

- Thao tác: 

+ D½ng c¹ng cֱ Edge Hightlighter (ph²m tԂt B) t¹ m¨u l°n phӺn h³nh Ӷnh b֗ 

xen kԐ v֧i nԚn . 

+ D½ng c¹ng cֱ Fill (ph²m tԂt G) ĽԜ t¹ v¨o phӺn b°n trong cֳa h³nh Ӷnh 

(phӺn kh¹ng b֗ xen kԐ v֧i nԚn). 

+ D½ng c¹ng cֱ Eraser (ph²m tԂt E) ĽԜ sֹa lӴi nhֻng phӺn thi qu§ tay. 

+ K²ch v¨o ph²m Preview ĽԜ xem trҼ֧c kԒt quӶ, sau Ľ· k²ch OK . Sau khi kԒt 

th¼c c¹ng vi֓c, c§c phӺn Ӷnh nԚn sԐ b֗ xo§ hԒt v¨ tr֫ th¨nh trong su֝t, ch֕ 

c¸n lӴi h³nh Ӷnh cӺn tr²ch xuӸt . 
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Bài 3: 

LêM VI֒C V֦I LAYER 

 

Trong bài này chúng ta sԐ tìm hiԜu vԚ Layer (l֧p). ņԜ thuԀn ti֓n cho vi֓c 

x ֹlý, chúng ta thҼ֩ng b ֝trí Ľ֝i tҼ֯ng trên nhֻng Layer ĽԜ khi x ֹlý Ľ֝i tҼ֯ng 

này không "dính dáng" gì ĽԒn Ľ֝i tҼ֯ng trên Layer kia. TӸt cӶ nhֻng gì liên 

quan ĽԒn Layer ĽԚu nԄm trên palette Layer . 

Các bӴn hình dung thԒ này: Layer gi֝ng nhҼ nhֻng tӸm phim hay tӸm kính 

trong su֝t ĽҼ֯c xԒp ch֟ng lên nhau, m֣i tӸm phim (hay kính) nhҼ vԀy g֙i là 

m֥t Layer, trên m֣i layer bӴn có thԜ b ֝ trí nhiԚu Ľ֝i tҼ֯ng (hình Ӷnh, vŁn 

bӶné).Khi bӴn làm vi֓c v֧i Layer nào thì ch֕ nhֻng Ľ֝i tҼ֯ng trên Layer Ľ· b ֗

tác Ľ֥ng, nhֻng Ľ֝i tҼ֯ng trên Layer khác không b ֗Ӷnh hҼ֫ng. Khi nhìn t ַtrên 

xu֝ng thì toàn b ֥Ľ֝i tҼ֯ng trên các Layer sԐ ĽҼ֯c nhìn thӸy nԒu nhҼ Ľ֝i tҼ֯ng 

bên dҼ֧i không b ֗Ľi֝ tҼ֯ng bên trên nó che khuӸt. BӴn có thԜ tӴo rӸt nhiԚu 

Layer trong m֥t file Ӷnh nhҼng hãy coi chַng vì khi Ľ· dung lҼ֯ng file là rӸt 

l֧n có thԜ làm treo máy cֳa bӴn. 

 Sau Ľ©y là mô hình  ĽҺn giӶn mô tӶ vԚ layer. 

 
Khi các bӴn bӸm F7 thì Palette Layer sԐ hi֓n ra (theo mԊc Ľ֗nh)Trong Palette 

này có nhiԚu Tab (Layer,chanel,path), các bӴn ch֙n Tab nào thì Tab Ľ· sԐ active 

và sԐ có các chֵc nŁng tҼҺng ֵng.  ֪bài này chúng ta Ľang làm vi֓c v֧i Tab 

Layer. 
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1. Các thao tác trên Layer 

1.1. Ch֙n Layer l¨m vi֓c 

Ch֙n Layer n¨o th³ k²ch chu֥t ngay layer Ľ·, 

ch֙n nhiԚu Layer th³ kԒt h֯p ph²m Ctrl r֟i lӺn 

lҼ֯t k²ch v¨o Layer mu֝n ch֙n.  

Sau khi ch֙n m֥t l֧p ta m֧i c· thԎ t¹ vԐ 

ch֕nh sֹa ĽҼ֯c c§c Ľ֝i tҼ֯ng tr°n l֧p Ľ·. 

 

1.2. Li°n kԒt layer :  

M֥t c§ch rӸt hi֓u quӶ l¨ li°n kԒt 2 hay nhiԚu Layer lӴi v֧i nhau. V֧i c§c 

Layer Ľ« ĽҼ֯c li°n kԒt, bӴn c· thԜ di chuyԜn v¨ biԒn Ľ֡i ch¼ng m֥t c§ch Ľ֟ng 

th֩i ĽԜ duy tr³ ĽҼ֯c v֗ tr² c֝ Ľ֗nh cֳa c§c phӺn 

Ӷnh tr°n Layer 

Ch֙n c§c layer cӺn li°n kԒt, nhӸp chu֥t v¨oBiԜu 

tҼ֯ng li°n kԒt (Link layer) hình móc xích  trên 

Layer panel, c§c layer Ľ« ĽҼ֯c li°n kԒt sԐ xuӸt 

hi֓n biԜu tҼ֯ng mԂt x²ch sau t°n layer.  Mu֝n 

hֳy li°n kԒt th³ nhӸp v¨o biԜu tҼ֯ng li°n kԒt lӺn 

nֻa. C§c Layer ĽҼ֯c li°n kԒt sԐ c· biԜu tҼ֯ng 
mԂt x²ch tr°n Layer. Khi di chuyԜn th³ c§c Ľ֝i 

tҼ֯ng tr°n c§c Layer Ľ« li°n kԒt sԐ di chuyԜn 

cùng lúc 

 

1.3. G֥p layer : 

 nhӸp chu֥t v¨o biԜu tҼ֯ng  ֫ ph²a tr°n phӶi cֳa Layer panel hoԊc kich chu֥t 

phӶi vào layer,  sԐ xuӸt hi֓n bӶng menu, trong Ľ· c· c§c lֽa ch֙n sau:  

+ Merge down : SԐ g֥p (merge) layer hi֓n h¨nh v֧i layer b°n dҼ֧i n· th¨nh 

m֥t, nԒu c· nhiԚu layer Ľang ĽҼ֯c ch֙n th³ sԐ g֥p nhֻng layer n¨y lӴi v֧i 

nhau,bӴn cȈng c· thԜ bӸm ph²m Ctrl-E ĽԜ thֽc hi֓n l֓nh n¨y. 

+Merge visible : Ch֕ g֥p nhֻng layer Ľang hiԜn th֗, b֛ qua layer Ӽn,bӴn c· 

thԜ bӸm ph²m tԂt Ctrl-Shift-E.  

+Flatten Emage : G֥p tӸt cӶ c§c layer trong file Ӷnh th¨nh l֧p duy nhӸt 

(background), nԒu c· layer n¨o Ľang Ӽn th³ photoshop sԐ h֛i ch¼ng ta c· vֵt 

b֛ nhֻng layer Ľang Ӽn kh¹ng 
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